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SCHOOL OF BUSINESS Syllabus
Course title: Customer Analytics
Course code: BAMA 520 - 001 Credits: 2
Class times: M/W 10-12 pm PST Class location:  Angus 437
Division: Marketing & Behavioural Science Co-requisites: n.a
Program: MBAN
Instructor: Yanwen Wang
Phone: 604-827-0078 Office location: HA 570
Email: yanwen.wang@sauder.ubc.ca Office hours: By appointment

Teaching assistant: Zining Wang
Email: zining.wang@sauder.ubc.ca

Traditionally, marketers have focused on the acquisition of new customers through mass advertising and
price-oriented promotions, accepting as a fact of life that newly acquired customers would eventually
switch to competitors. Today, the focus has changed from customer acquisition to customer development
and retention, particularly for the firm’s best customers. This shift from customer acquisition to
development and retention requires a new mindset from product-centric to customer-centric
management and raises new questions. For instance, what is the maximum amount a firm should spend
to acquire a customer? Should firms want to keep their customers forever? What can be learned from
customer defection?

New forms of information technology provide increasingly rich data of individual-level customer behavior
to address these issues but few firms have the expertise to intelligently act on such information. This
course will provide students with the analytical tools that are necessary for understanding and predicting
customer behavior and assessing customer lifetime value. The course will be grounded in relevant
academic work as well as cases and exercises covering a broad set of industries and applications.

You will develop a deep understanding of customer centricity and its implications for the firm, learn about
state-of-the-art methods for calculating customer lifetime value and customer equity, and develop the
analytical and empirical skills that are needed to judge the appropriateness, performance, and value of
different statistical techniques that can be used to address issues around customer acquisition,
development, and retention.

Class time will be used for a combination of lectures, discussion, solving sample problems, and case
discussions. Attendance is expected to accomplish the learning objectives below. Lectures and
discussions will assume that students having pre-read the corresponding chapters and case studies as
listed in the course schedule below.

By the end of this course, students will be able to:
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1. Understand the importance of customer-centric valuation

2. Link customer satisfaction, loyalty program, and recommendation system with the broad concept of
customer relationship management

3. Apply key customer value analytics tools to a real customer database

4. Recommend strategies based on customer relationship analytics

Component Weight
Individual assignments 15%
Group assignments 40 %
Final exam 35%
Class participation _10%
Total 100%

Individual Assignments (5*3%)
There are three individual assignment during the term. They may be in-class or after-class exercises. The
objective is to help you gain a better understanding of the skills taught in class.

Group Assignments (10%*4)

Each group has 4 team members. You will stay in the same team for all the group assignments. If you want
to choose team member and form your own team, please form your teams on Canvas under the “People
- > Group Assignment” sector by midnight Sep 5 2023. If you do not form a team by then, | will randomly
assign you to a group and reveal group formation information in class on Sep 6 2023.

Please answer all the suggested questions for each group case write-up. The objective is to help you learn
data analysis skills through practice and from each other. Group assignments must be prepared
individually for each group. Sharing work across groups is strictly prohibited in line with the RHL Academic
Misconduct Regulations. Peer evaluations will be conducted at the end of semester.

Peer evaluations will be completed at the end of the term to provide feedback on how team members
think each member (including their own) is contributing to the group project. Individual grades on group
assignments may be subject to adjustment following my review of peer evaluations. Reductions can be
significant, ranging from a decrease of 10% to a decrease of 100% if an individual has contributed little
or nothing to the team’s work. In most instances, where team members are reliable and contribute, no
adjustments are made.

Students are required to complete peer evaluations by the specified deadline (announced before the
end of the class). Failure to complete the evaluation will result in a 10% reduction in the mark received
for the group assignment portion of this course (for example if you got 40 out of 40 on the group
assignment score and did not complete peer evaluations your total group score will be adjusted to 36).
Please ensure that you complete the peer evaluations on time.
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Class Participation (10%)
We will devote a significant portion of class time to solving practice problems and cases. In order to
maximize the benefits to you, it is of utmost importance that you be prepared to discuss the materials
during class. For effective class participation includes:
(1) complete all the class activity on time. All the class surveys are designed to help facilitate in-
class discussions.
(3) install all the software prior to the in-class lab sessions,
(4) ask questions about concepts related to class or lecture contents,

- (5) share your experience or point of view with the class,
Note that attending class and not speaking has neither a positive nor a negative impact on your
participation score.

Final Exam (35%)
The final exam will be a computer-based exam. For details to be reviewed in class.

Course pack

There is no required textbook for this course. Instead, we will use a combination of cases and articles
for readings. All the class materials can be accessed from Canvas or through purchase (see Course Pack
info below).

1. Go to the Ivey Publishing website at www.iveypublishing.ca

2. Log in to your existing account or click "Register" to create a new account and follow the prompts to
complete the registration. If registering, choose the "Student" role.

3. Click on this link or copy into your browser: https://www.iveypublishing.ca/s/ivey-
coursepack/alR5c00000FvZroEAF

4. Click "Add to Cart".

5. Go to the Shopping Cart (located at the top of the page), click "Checkout", and complete the checkout
process.

6. When payment has been processed successfully, an Order Confirmation will be emailed to you
immediately and you will see the Order Confirmation screen.

7. Once you have completed your order, click on your username on the top right --> Orders -->
Downloads

IMPORTANT: Access to downloadable files will expire 30 days from the order date, so be sure to save a
copy on your computer. The downloadable file is a PDF document that can be opened using Adobe
Reader.

This material is for your personal use only and is not to be shared or distributed in any form.

You will also be required to use R and Excel Toolpak in this course. Please follow the instructions below

to install the software.
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R and Rstudio
- Install R-base first:
o For windows https://cran.r-project.org/bin/windows/base/
o For mac http://lib.stat.cmu.edu/R/CRAN/
- Next follow the guidelines to install RStudio desktop Free
version: https://posit.co/download/rstudio-desktop/

Excel Analysis Toolpak

You must have Excel 2019/2016 for Mac or 2019/2016/2013 for Window. UBC provides access to
download Microsoft 365 for free (Microsoft 365 includes Excel 2016). Here’s the link:
https://it.ubc.ca/services/desktop-print-services/software-licensing/office-365-students

Mac Users

- Click the Tools menu, and then click Excel Add-Ins.

- Inthe Add-Ins available box, select the Analysis ToolPak check box, and then click OK.

- If Analysis ToolPak is not listed in the Add-Ins available box, click Browse to locate it.

- If you get prompted that the Analysis ToolPak is not currently installed on your computer, click
Yes to install it.

- Quit and restart Excel. Now the Data Analysis command is available on the Data tab and the
Tools menu.

Windows Users

- Click the File tab, and then click Options.

- Click Add-Ins, and then in the Manage box, select Excel Add-ins.

- Click Go. In the Add-Ins available box, select the Analysis ToolPak check box, and then click OK.

- If Analysis ToolPak is not listed in the Add-Ins available box, click Browse to locate it.

- If you get prompted that the Analysis ToolPak is not currently installed on your computer, click
Yes to install it. After you load the Analysis ToolPak, the Data Analysis command is available in
the Analysis group on the Data tab.

Late submissions will not be accepted and will receive a grade of zero.

If extenuating circumstances arise, please contact the RHL Graduate School program office as early as
reasonably possible, and submit an Academic Concession Request & Declaration Form
https://webforms.sauder.ubc.ca/academic-concession-rhlee. If an academic concession is granted
during the course, the student will be provided options by RHL, or by the instructor in consultation with
RHL, per UBC's policy on Academic Concession.

BAMA 520 4 August 27, 2023
Program: MBAN



https://cran.r-project.org/bin/windows/base/
http://lib.stat.cmu.edu/R/CRAN/
https://posit.co/download/rstudio-desktop/
https://it.ubc.ca/services/desktop-print-services/software-licensing/office-365-students
https://webforms.sauder.ubc.ca/academic-concession-rhlee
http://www.calendar.ubc.ca/vancouver/index.cfm?tree=3,329,0,0

UBC ) | SAUDER GRADUATE SEHOOL

SCHOOL OF BUSINESS Syllabus

Code plagiarism falls under the UBC policy for Academic Misconduct. Students must correctly cite any
code that has been authored by someone else or by the student themselves for other assignments.
Cases of "reuse" may include, but are not limited to:

e the reproduction (copying and pasting) of code with none or minimal reformatting (e.g.,

changing the name of the variables)
e the translation of an algorithm or a script from a language to another
e the generation of code by automatic code-generations software

An “adequate acknowledgement” requires a detailed identification of the (parts of the) code reused and
a full citation of the original source code that has been reused.

Students are responsible for ensuring that any work submitted does not constitute plagiarism. Students
who are in any doubt as to what constitutes plagiarism should consult their instructor before handing in
any assighments.

Excepting extenuating circumstances, students are expected to attend 100% of their scheduled class
hours. Absent students limit their own academic potential, and that of their classmates, and cause
unnecessary disruption to the learning environment. Students missing more than 20% of the total
scheduled class hours for a course (including classes held during the add/drop period) without having
received an academic concession will be withdrawn from that course. Withdrawals, depending on
timing, could result in a “W” or an “F” standing on the transcript.

If a student feels unwell, they should stay home and send a courtesy email to each impacted instructor
and cc their program manager. The student should also submit an Academic Concession Request &
Declaration Form.

If a student suspects possible COVID-19 infection, they should use the BC Ministry of Health’s self-
assessment tool, to help determine whether further assessment or testing for COVID-19 is
recommended.

If a student is required to self-isolate (e.g., while waiting for test results), they should follow the steps
above (stay home, email instructor(s) and program manager, submit an Academic Concession Request &
Declaration Form, and follow BC Health Guidance.

Students who are required to quarantine, should get in touch with their Program Manager to discuss the
possibility of academic concessions for each impacted course. The Program Manager will work closely
with your instructors to explore options for you to make up the missed learning.

Visit the following website for the most recent updates regarding COVID-19 protocol on campus:
https://students.ubc.ca/campus-life/returning-to-campus
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Students are expected to arrive for classes and activities on time and fully prepared to engage. Late
arrivals may be refused entry at the discretion of the instructor or activity lead. Students arriving later
than halfway through a scheduled class will be treated as absent for that class.

In-Person Regulations

Devices such as laptops, tablets, and cell phones are not permitted to be used in class unless directed by
the instructor for in-class activities. Students who do not follow the School’s policy in this regard may be
required to leave the room for the remainder of the class, so that they do not distract others. Research
shows that students’ use of laptops in class has negative implications for the learning environment,
including reducing their own grades and the grades of those sitting around them.

Please use the American Psychological Association (APA) reference style to cite your sources.

Details of the above policies and other RHL Policies are available at:
http://www.calendar.ubc.ca/vancouver/index.cfm?tree=12,199,506,1625

UBC provides resources to support student learning and to maintain healthy lifestyles but recognizes
that sometimes crises arise and so there are additional resources to access including those for survivors
of sexual violence. UBC values respect for the person and ideas of all members of the academic
community. Harassment and discrimination are not tolerated nor is suppression of academic freedom.
UBC provides appropriate accommodation for students with disabilities and for religious observances.
UBC values academic honesty and students are expected to acknowledge the ideas generated by others
and to uphold the highest academic standards in all of their actions. Details of the policies and how to
access support are available on the UBC Senate website at https://senate.ubc.ca/policies-resources-
support-student-success.

The UBC Sauder School of Business strives to promote an intellectual community that is enhanced by
diversity along various dimensions including status as a First Nation, Metis, Inuit, or Indigenous person,
race, ethnicity, gender identity, sexual orientation, religion, political beliefs, social class, and/or
disability. It is critical that students from diverse backgrounds and perspectives be valued in and well-
served by their courses. Furthermore, the diversity that students bring to the classroom should be
viewed as a resource, benefit, and source of strength for your learning experience. It is expected that all
students and members of our community conduct themselves with empathy and respect for others.

The academic enterprise is founded on honesty, civility, and integrity. As members of this enterprise, all
students are expected to know, understand, and follow the codes of conduct regarding academic
integrity. At the most basic level, this means submitting only original work done by you and
acknowledging all sources of information or ideas and attributing them to others as required. This also
means you should not cheat, copy, or mislead others about what is your work. Violations of academic
integrity (i.e., misconduct) lead to the breakdown of the academic enterprise, and therefore serious
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consequences arise and harsh sanctions are imposed. For example, incidences of plagiarism or cheating
may result in a mark of zero on the assignment or exam and more serious consequences may apply if
the matter is referred to the President’s Advisory Committee on Student Discipline. Careful records are
kept in order to monitor and prevent recurrences.

During this pandemic, the shift to online learning has greatly altered teaching and studying at UBC,
including changes to health and safety considerations. Keep in mind that some UBC courses might cover
topics that are censored or considered illegal by non-Canadian governments. This may include, but is not
limited to, human rights, representative government, defamation, obscenity, gender or sexuality, and
historical or current geopolitical controversies. If you are a student living abroad, you will be subject to
the laws of your local jurisdiction, and your local authorities might limit your access to course material
or take punitive action against you. UBC is strongly committed to academic freedom, but has no control
over foreign authorities (please visit http://www.calendar.ubc.ca/vancouver/index.cfm?tree=3,33,86,0
for an articulation of the values of the University conveyed in the Senate Statement on Academic
Freedom). Thus, we recognize that students will have legitimate reason to exercise caution in studying
certain subjects. If you have concerns regarding your personal situation, consider postponing taking a
course with manifest risks, until you are back on campus or reach out to your academic advisor to find
substitute courses. For further information and support, please visit: http://academic.ubc.ca/support-
resources/freedom-expression

All materials of this course (course handouts, lecture slides, assessments, course readings, etc.) are the
intellectual property of the instructor or licensed to be used in this course by the copyright owner.
Redistribution of these materials by any means without permission of the copyright holder(s)
constitutes a breach of copyright and may lead to academic discipline and could be subject to legal
action. Any lecture recordings are for the sole use of the instructor and students enrolled in the class. In
no case may the lecture recording or part of the recording be used by students for any other purpose,
either personal or commercial. Further, audio or video recording of classes are not permitted without
the prior consent of the instructor. Students may not share class Zoom links or invite others who are not
registered to view sessions.

UBC's Point Grey Campus is located on the traditional, ancestral, and unceded territory of the
xwmabkwayam (Musqueam) people, who for millennia have passed on their culture, history, and
traditions from one generation to the next on this site.
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COURSE SCHEDULE
(Subject to change with class consultation)

Sep 6 (W) Introduction to Customer Analytics
Sep 8 (F) Customer Lifetime Value & R lab session
Sep 11 (M) Value of Data IA 1 due GA 2 in-class
Sep 13 (W) | Linear Regression & Margins | IA 2 in-class GA 1 due
Sep 18 (M) Linear Regression & Margins Il
Sep 20 (W) | Customer Acquisition & Retention GA 3 due
Sep 25 (M) | Field Experiment |
Sep 27 (W) | Field Experiment Il GA 4 in-class
Oct 4 (W) Segmentation IA 3 in-class
Oct 6 (F) Advanced topic
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